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WARNING!

e This update is only available to customers who already own a license for Medmont Studio 6.
Customers who wish to upgrade from an earlier version can contact Medmont or your local
Distributor.

e The recommended minimum specifications for Medmont Studio have been revised for this update.
Please consult the Medmont website before installing this version.
http://medmont.com/support/

e Upgrading from Version 3 is no longer possible. If upgrading from Version 3, first upgrade to Version
6.1.1 before upgrading to Version 6.2.0 or later.

e This version no longer supports Microsoft Windows XP.

e  For most customers, this upgrade will require a lengthy database copy operation, please ensure there
is adequate time to perform this copy. As a basic guide a 300MB database will take approximately
30mins to upgrade.

e Llanguage support includes English, French, Chinese (Simplified), Spanish, German, Czech, Dutch and
Italian. If you require a language which was available in a previous version of Medmont Studio, then
continue using your existing version until your preferred language becomes available.

Release Dates

Release Date Type Release Version
27" February 2019 Minor 6.2.7
4™ April 2018 Minor 6.2.6
4™ December 2017 Minor 6.2.5
28" July 2017 Minor 6.24
29" May 2017 Minor 6.2.3
16" May 2017 Minor 6.2.2
21 April 2017 Minor 6.2.1
31 March 2017 Major 6.2.0
239 December 2015 Minor 6.1.1
11" December 2015 Major 6.1.0
15" December 2014 Minor 6.0.3
15" October 2014 Minor 6.0.2
3'Y October 2014 Minor 6.0.1
10" September 2014 Major 6.0.0
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6.2.7

New Features

E300
«  Support for new contact lens designs, including;
o Maidige (MDG): MDG-1

Improvements

E300
« Added support for modern multithreaded approach to contact lens simulation. This will greatly
speed up and stabilize contact lens simulations on modern PC’s with new generation
Processors
DVv2000
Ability to adjust the following image settings for Keeler slit lamps using the ukEye camera system:
o Gamma
o Gain (Master, Red, Green, Blue)
o Base Black Level

6.2.6

New Features

Medmont Studio
+ Added three new languages: Czech, Dutch and Italian

E300
+ New attribute “Sagittal Difference at 8mm”. To display this attribute along with your other
attributes, select an E300 Exam from the explorer pane and select the Arrange ¥4 button
at the top of the “Data” pane and move the attribute into the “Selected” column in the
Arrange window.
«  New Toric contact lens by OrthoTool™

M700
- New Perimeter Diagnostic Tool. This allows in-field viewing of the self-test voltage
readings for remote support purposes.

Improvements

E300
+ Renamed Zernike Co-efficient “Trifoil” to “Trefoil”
+  Renamed “KATT BE Free MC” to “KATT MC” due to incorrect labeling in previous version.

M700
+ Increased the acceptable -5volt limits for the self-test from -5.2v to -5.4v.
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6.2.5

Improvements

Medmont Studio

E300

6.2.4

New Features

Medmont Studio

Improvements

Medmont Studio

6.2.3

Improvements

Medmont Studio

E300

Fixed issue where sites with a large number (> 3) of clients connected at the same time
may experience server drop-outs. Restarting the server would normally rectify the problem
temporarily.

Fixed issue where local SQL Servers are not listed in the available servers dropdown list
when running on x64 based PC.

Renamed the KATT MC Contact Lens Design to BE FREE MC.

Added two new languages: German and Spanish.

Patient’s whose names use Chinese characters can now be found using the Find Patient
window and Patient Search Bar at the top of the Patient Tree.
Improved overall user interface responsiveness when changing view types.

New KATT Contact Lens Designs; BE Free and MC lenses.

Fixed issue missing E300 bitmap when exporting as part of Link Application.

Fixed layout issue of Combination view — Current Display report.

Calibration reminder no longer displayed if calibration results in no further action required.

Three Zone Print Report no longer displays the attribute pane (right) and section pane
(bottom)

Fixed issue updating an existing Version 6 database which was copied from another PC onto a
PC without an existing Medmont Studio installed.

The Medmont Studio Configuration Tool now retains the previous 10 log files in a sub-folder
called “Logs” relative to the running folder.

Fixed issue with Pupil Annotations not being displayed after capturing exams with the “Skip
Review” option selected during a single topography capture.
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6.2.2
Improvements

Medmont Studio
«  Fixed problem with displaying permissions when editing a clinician.

E300
«  Fixed issue with incorrect sequence time when importing from a file exported from an earlier
version of Studio running on non-English Windows.

M700
. Fixed problem with data blocks (text on the image map) showing incorrect characters in Chinese
(Simplified).

6.2.1
Improvements

Medmont Studio

+ Increased the database connection timeout to avoid failed connections to LocalDb and SQL
server.

« Improved error handling and reporting of the data migration process.

. Fixed issue where External IDs would be missing when migrating from MS Access database.

« Improved Chinese (Simplified) translations for perimetry.

- Fixed issue of failed installations on non-English versions of Microsoft Windows operating
system.

6.2.0
Important notes

« The recommended minimum specifications for Studio have been revised for this version. Please
consult the Medmont website before installing this version.

+ Upgrading from Version 3 is no longer possible. If upgrading from Version 3, first upgrade to
Version 6.1.1 before upgrading to Version 6.2.0 or later.

« Language support includes English, French and Chinese (Simplified). If you require a language
which was available in a previous version of Medmont Studio, then continue using your existing
version until your preferred language becomes available.

«  This version no longer supports Microsoft Windows XP.

«  For most sites this upgrade will require a lengthy database copy operation, please ensure there
is adequate time to perform this copy. As a basic guide a 300MB database will take
approximately 30mins to upgrade.

New Features

Medmont Studio
«  Support for Microsoft’s LocalDB database technology. Replacing the legacy MS Access
database, this technology extends the data storage capability to 10GB and adds great new
features like backup and restore.
+  New Backup and Restore capability means that its now easier to keep your important patient
data safe and secure. See Help for more details.
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E300
- Faster calibrations though better utilization of computers with multiple cores.
«  Support for new Contact Lens Designs, including;
o OrthoTool
o Euclid: Emerald
o Belgian Optical Supply: Oxyflex & Oxyflex Special
o Art Optical: Ampleye 15, Ampleye 16.5 & Ampleye Quad
o Paragon: ICD Flex 14.8 & ICD Flex 16.3
+  New estimated height attributes.
«  New extrapolated height data export — to include the extra height data in export files you must
first enable it from the Configure > Preferences dialog box.
DVv2000

Improvements

Medmont Studio

E300

« Improvements to the new capture wizard based on user feedback.

- Improved contact lens fitting algorithm to show areas of lens touch.

+ Increased diameter (up to 18mm) for the Multi-curve contact lens design.
DV2000

New Automatic Update Service - Studio updates now pushed to the clients when the client and
server versions are different. This will not be effective until after clients have been updated to
version 6.2.0 or later.

Moveable Tabs — Bottom and Right-hand data tabs can now be swapped based on user
preference.

Medmont Help files are now deployed in Microsoft Compiled Help (CHM) format.

New support for Sun Kingdom LS-5 Slit-lamps

New support for Inami Slit-lamps

Keeler eye L/R sensor swap option. This option is available from the Keeler image source
settings dialog.

Updated Optomate Touch PMI settings to align with the default installation of Optomate Touch.
Fix category filter reset problem when selecting between patients.

Allows multiple instances of the same annotation type. So, for instance, the freehand annotation
can be used to outline multiple scotomas and have attributes for total, averages, etc

Improved embossing function.

Canon ED SDK updated to the latest version 3.4.

Improved video support - including in-place video controls and user clickable video progress
bar to set the video play position.
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6.1.1

New Features

E300
«  New Auto TBUT classification for displaying correct colorization (green:normal, yellow:suspect
and red:abnormal) in the Data pane.

Improvements

Medmont Studio
«  Fixed issue with annotations created with non-standard characters (not part of the Latin English
alphabet) not appearing on the image even though they appear in the Annotation entry window.

E300
. Fixed issue with tear film images showing cropped when displaying multiple exams at once.
Images are now rescaled if the area does not allow for the unscaled image.
« IS Index attribute now showing the correct colorization when the superior hemi field has the
higher power.
. Fixed issue with Flat Axis parameter not changing the lens geometry for an ICD 16.5 contact
lens.

DV2000
« Changed the maximum allowed capture memory to be a calculation based on available system
memory and architecture rather than a fixed 512 MB.

6.1.0

New Features

Medmont Studio
«  Support for Microsoft® Windows® 10 Operating System.
«  Crystal Practice Management software is now supported. It can be selected from the standard
PMI list within Medmont Studio Configuration Tool.
« Added support for French and Chinese (Simplified) languages.

E300
+  New capture user interface. The new wizard style interface provides support for different
capture modes;

o Standard Corneal Topography — guides the user through the capture and review
process to ensure good captures every time.

o Video Topography — guides the user through the capture of exam sequences and
allows analysis and review before saving.

o Composite Topography — steps the user through the capturing of five images at
different gaze angles and allows user review before saving the composite image.

o Tear Film Capture — guides the user through capturing tear film breakup video
sequences.
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«  New Tear Film Capture and Analysis.

o Tear Film Capture wizard automatically starts capturing when the patient blinks twice
and continues to capture until the patient blinks again.

o Tear Film exam type means that analysis time and storage of exams is optimized for
practices wanting to include Tear Film capture as standard level of care.

o Tear Film Breakup Map displays the time taken for the TFSQ to reach a threshold
defined as probable breakup.

o TFSQ Area versus Time graph positioned right below the Tear Film image shows
Attribute data over time. Any data point can be selected to jump straight to the map at
set time.

o Auto TBUT attribute automatically calculates the TBUT for the current exam.

- Added new instrument calibration prompt. If the topographer has not been calibrated within the
past 6 months a prompt is shown each time a new examination is started until a calibration is
performed.

-« New HVID indicators to the Contact Lens Profile pane. This requires the iris to be defined
manually using the Iris annotation. The pupil is automatically defined for most maps otherwise it
must be defined using the pupil annotation.

- New ICD 14.5 Contact Lens Design by Paragon.

DV2000
- Added support for the Keeler Slip lamp H Series which uses an IDS ukye 2250SE USB digital
camera.

- File Watcher image source has a new option to delete all files in the watched folder when the
image source is opened (the capture window is opened). This is useful for supporting third party
capture software which require an empty folder on startup.

«  Support for the imageSPECTRUMCapture software from Canon. This is supported using the File
Watcher image source. Please ask your Medmont distributor for an importable image source file.

Improvements

Medmont Studio

- Moved “Data” tab from below the exam image to instead appear on the right side of the exam
image. It can also be shown or hidden from the Display > Panes > Right ribbon bar menu button.

- Medmont Studio Configuration Tool now allows installation of the W18 video drivers. The W18
Video Converter is a useful replacement for Video Capture Cards required by some older
analogue cameras.

- Install button on the License Manager window renamed to Manage to better reflect its actions.

- Fixed issue whereby the last result saved was not being selected in the patient tree when the
test window was closed.

- Removed email results option from the Medmont Studio Configuration Tool. The icons can still
be added to the main menu by copying the email external link app into the Links folder.

- Forced the use of NotTrusted security for all Optomate Touch connections since Optomate
Touch connections always require a user and password to connect.

- The Medmont Configurational Tool now defaults the data path to an appropriate path when
upgrading from V4 or V5 software.

- Consistent naming of shortcuts in the Start Menu.

. TCP Port number used for communications between the server and clients can now be set
using an entry field in the Medmont Studio Configuration Tool
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+ A minimum range can now be set for regression graphs to ensure large variations are always
within the graph without collapsing the Y-axis too much when the data is not spread out.

- Fixed issue where no patients were displaying on startup when the Display only one patient in
Explorer Pane option is selected and Studio is launched from a third-party Practice Management
System.

+ Regression view export data is now sorted by exam date.

+ Added new Copy To function to the Attributes window. This allows attributes to be copied
between different exam types.

«  Scleral Angle Adjustment is now being saved as part of the Paragon ICD lens including the
existing 16.5 ICD lens as well as the new 14.5 ICD lens.

« Video exams are loaded in the background allowing the video to start playing before all the
video frames are loaded.

« Changed the Weighted Average Height calculation to require data at both ends of the specified
chord. If height data is missing from either or both ends of the chord the value “No Data” is
displayed.

+ Added new Contact Lens ribbon bar tab. This allows changing a lens design or modifying the
parameters of an existing lens as well as save and undo.

DV2000

. Fixed error message appearing when creating a Point Grey image source. The error message
was “An unexpected error (Could not find any resources appropriate for the specified culture....”

- Video frames are now loaded in the background allowing video to start playing before all
frames are loaded.

« AVT Marlin camera now supported in Windows® 7 and Windows® 8 64bit operating systems.

«  Fixed issue with capture window moving to the background when playing back recorded video.
This was particularly noticeable when operating on a single monitor as the main window was
overlapping the capture window.

« Updated ARTRAY SDK to version 1.2.8.13.

« Updated Canon ED SDK to the latest version 3.2.1. This add support for a variety of new SLR
cameras. Please contact your authorized distributor to check if support is available for your
preferred camera.

M700
+ Added a Fast button to the Test window menu bar to make it easier to differentiate between
using the slow and fast patient response times.
« Fixed issue where a test could not be resumed if a connection was lost midway through a test.
Tests can now be resumed after a connection is reestablished.
«  Change so that points are always tested in a different random order. Previously the points
where tested in the same recurring random order.

6.0.3

New Features

Medmont Studio
+ The Medmont Studio Configuration Tool has been revised to better guide users through the
options of creating, upgrading and using existing Medmont Studio databases.
+  Web page shortcuts have been added to the start menu for quickly accessing the Medmont
Studio Support and Medmont Studio User Forum pages.
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«  Medmont Studio now supports different scaling settings which make the software easier to use
by people who are vision impaired.
E300
- Calibrations are now sorted by serial number when viewing them in the instrument tree.

Improvements

Medmont Studio

« Can now use the delete key to remove patients and exams. Also, added the ability to delete
E300 calibrations and individual calibration images from the calibration list.

«  Clicking on the “Custom” button when configuring practice management integration in the
configuration tool now correctly adds the imported settings for future upgrades of Medmont
Studio.

« Buttons in the View menu which are added to the Quick Access Toolbar are now remembered
between sessions of Medmont Studio.

. Fixed a registration issue when users attempted to use a non-default location for storing their
data.

+  Removed requirement for proxy servers to support Expect 100 Continue when registering.

«  Fixed issue with some drop-down menus still being shown after opening and closing the menus
on systems using multiple screens.

«  Fixed issue with annotations menus still being shown in popup menu (rightclick) after clicking
away from an annotation.

E300

- Calibrations are now always saved upon leaving the calibration wizard. This avoids issues on
client/server installations when the client has temporarily lost its connection to the server during
a calibration.

«  Fixed “Null reference exception” error displayed when viewing regression graphs for E300
video exams and capture sequences.

«  Fixed “ArgumentException” that was randomly being displayed when quickly changing between
selections in the E300 calibration file list.

« Changed the Corneal Height Extrapolation algorithm (used for contact lens fitting) to improve
correlation with measured data for composite exams.

6.0.2
Improvements

Medmont Studio
«  The prompt to uninstall a license during an upgrade is no longer displayed.
«  Fixed “No Drive Specified” error message displayed when selecting not to perform a legacy
upgrade after having previously selected a legacy Version 4 or 5 upgrade within the same
configuration session.

6.0.1
Improvements

Medmont Studio
« Fixed anissue where upgrading from version 4 to version 6 would clear the external patient ID’s
if no practice management system was in use.
«  DICOM functionality no longer requires a license.
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E300
« The wrong lens was being created when new manufacturer was selected from the manufacturer
dropdown list.

6.0.0

New Features

Medmont Studio

«  License transfer is now possible without involvement from Medmont. The number of license
transfers is limited to two. A software license is uninstalled when the software is uninstalled
using the Add Remove Programs feature in Windows®

- Licensing and registration of the software is now handled separately. Distributors can now
license the software but leave the registration for the end-user.

« Licenses can be updated without requiring the Activation Key by pressing the Update button
now available in the License Manager window (requires a working internet connection).

- Local caching of image data avoids lengthy delays in multi-site installations where upload
bandwidth is limited.

« Improved look and feel.

o The Print, Export and Refresh menus are now easily found in the File menu tab.

o The exam tabs have now been consolidated into a single Exams tab. The displayed
columns will now change based on the exam type selected.

o The data blocks which were overlaid over the image are now displayed in a tab
underneath the image called Data.

o Added exam category information to summary text in patient tree. Tags can now be
assigned a foreground and background color.

«  Each attribute can now include a classification function which can return one of three values;
Normal, Suspect or Abnormal. As a result the attribute will have a green, yellow or red
background respectively.

+ Added the ability to export regression view data. This is limited to only single point regression
data. Data displayed as histograms is not exported.

«  Support added for the new Optomate® Touch Practice Management System.

« A new step has been added to the Configuration Tool for Server installations to select the
network interface card to use. This allows support for computers which have multiple network
interface cards (NICs).

« Annotations can now be locked into position. This is to avoid the issue of accidentally moving an
annotation when performing a point-by-point analysis.

. OfficeMate PMS now included in the default set of Practice Management Integrations displayed
in the Configuration Tool.

E300
«  Tear Film Surface Quality (TFSQ) analysis. A new Tear Film Quality map view gives an indication
of the tear film quality over the surface of the eye. The following attributes have also been
added;
o TFSQ — attribute gives an average of the local Tear Film Quality over the entire eye.
o TFSQ Central — provides the same but for only the central region (4mm chord) of the
eye.
« Added the following new Contact Lens Designs Manufacturer; Design(s)
o LCS; Aeria and EyeBrid
o Nordiska Lins AB; Nordiska Lins A-Design
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DV2000

« Added support for CSO slip-lamp cameras using the SSLive.exe capture interface. This feature
requires the installation of the Phoenix capture software.

« The image capture dialog is now capable of capturing images, image sequences and videos all
within the same window. For instance, no need to close the capture window and re-open when
changing from single image to video.

- Frame time now displayed in the top-left corner of the playback window. This is useful for
identifying the frame which is displayed when a video playback is paused.

Improvements

Medmont Studio

« Added an Update button to the License Manager so that the activation key does not have to be
re-entered when new components are added or the sessions limit is updated.

. Fixed issue with applying more than one annotation to an exam. The problem was only
observed when you expand one of the exam windows from a combination view.

«  Fixed “Cannot open any more tables” error being displayed when you start Medmont Studio for
large multi-site installations.

« It's now possible to change the location of the component files (E300\M700\DV2000 folders)
after it has been set for an MS SQL Server installation.

«  Changes made to allow Email to be sent from a 64-bit mail client.

+ A new export file type (MCO) has been added to avoid Microsoft® Outlook® from blocking
exported data attachments

«  The Link mechanism now allows files to be exported with a unique name (GUID). The string
{GUID} can be used in place of the export name. Both the .MXF file and the image file (if
specified) shall be assigned the same name.

- DICOM — Changed the settings so a different AE Title can exist for PACS and Worklist server.

« DICOM — Renamed the Storage Area field in the Worklist settings to AE Title of peer

+ DICOM — Several attributes are now assigned values for each exam submitted to a PACS, these
include;

o Study Date, Study Time, Modality, Manufacturer, Manufacturer Model Name and
Software versions.

« The data location can now be changed after setting it the first time when configured to use

Microsoft® SQL Server®. The option was not available in previous versions.

E300

« The Freestyle Lens Design has been modified to calculate the back surface from the data
calculated from the contact lens axis rather than the instrument axis.

. Fixed “Index out of range” error appearing when the Analyze All button was pressed in the
E300 capture window after previously capturing a large number of images.

«  Fixed “Canvas:Paint” error displayed when changing the selected E300 exam with the Elevation
map selected.

« Scaling of perspective view has been improved to better visualize astigmatic eyes.

«  SimK values now displayed with two decimal places.

+ New Recalculate Attributes button on the E300 > Analysis ribbon.

«  E300 Converter box firmware version is now being logged to the E300VideoSource.log file
located in the Common Application data folder

+ Fixed Unhandled Exception (Zoned Keratometrics) being raised while analyzing some E300
exams with significant eyelash interference.

+  New Attribute functions have been added to get Wavefront Error and Ray Error for a given
radius and angle.
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- Fixed issue whereby images which had previously been saved against one patient are move to
another patient if the images are not cleared when selecting a new patient in the one capture
session.

«  Fixed error shown when comparing a standard E300 capture with a composite capture.

+ Replaced Residual Astigmatism attribute for contact lenses with Lens Power (Toric). This is the
full calculated refraction (including cyl) required to correct any residual astigmatism. These
values and other lens design parameters are displayed in the Data tab.

DVv2000
«  The watched folder will no longer change to a default location if the specified watch folder is
unavailable.

«  The Y-axis of the regression graphs now displays the scale with the same numeric formatting as
the attribute being graphed.

M700

. Fixed issue preventing the Attributes from being printed on the current display print report.

«  The numeric map display will automatically display in linear scaled mode when viewing an exam
with a retinal overlay defined. Selecting an exam without an overlay reverts back to the previous
scale mode.

« Changes made to force the video converter to always use the composite input instead of the s-
video input which was causing a black fixation window on some computers.

« Sound events are no longer available through the Windows® > Sounds applet. Sounds are now
managed by Medmont Studio through the Preferences window.

« Non-linear scaling can no longer be enabled when viewing a visual field result with retinal image
overlaid.
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